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How to Make a Data Entry Form in Access (2007)

A data entry form simplifies data entry and utilizes the power of the relational database. First, it lets you create a form to enter your data in a more user-friendly way than simply entering it into the columns in a table. Second, a data entry form allows you to automate the relationship between a main table and subtables, by embedding a subform into the main form and specifying what field should link the two. And third, you can embed a lookup table into the form in order to standardize data entry for known codes. There are also ways to add to the code, or collect uncoded entries, so having a data entry form enhances your flexibility for handling qualitative data and does not constrain it. 


In order to create a data entry form you must first create the table(s) that will hold the data. This tutorial assumes you have already created at least one main table that collects data from your major unit of analysis, at least one sub-table that stands on the many side of a one-to-many relationship to the main data table, and at least one lookup table whose codes refer to a field on either the main table or sub-table.
Creating the Form for the Main Table


Access 2007 tries to be too helpful, and can do things you do not want. I am going to teach you the most basic ways to create the form, so you will have the most flexibility to get the form to do exactly what you want it to do. We will start with the Form Wizard so you can see the steps, but then we will work from a blank form.

Using the Form Wizard 
1. Open your Access 2007 database. It will be displaying Tables in the menu section at the left. If you click on the Dropdown arrow at the top, it will display a list of choices. There is a section called “Navigate to a Category” and a section below that called “Filter by Group.” Under “Filter by Group” find the one called FORMS and click on that. If it displays your table in the main window, close the table. 
2. At the very top of the Access screen, find the CREATE tab to the right of the HOME tab and click on it. It has sections for creating Tables, Forms, Reports, and Queries. In the Forms section, DO NOT click on the first icon to create a form for one table. It will give you an instant form, but one that you cannot adapt. 

3. Instead, click on MORE FORMS and in the little window that opens up, click on FORM WIZARD. 

4. This opens a Form Wizard that will walk you through the basic process. The first page asks which fields you want on your form. There is a box to select the Tables or Queries you want in your form. Click on the main table you have created and in the left window below you will see a list of the Available Fields in that table. If you want all the fields on the table to be on your form, click on the icon with two right arrows and all of the fields will shift to the Selected Fields list on the right. You could also use the single right arrow to move fields one at a time to the Selected Fields list. Notice that now the left arrow buttons are available if you want to un-select either the whole list or individual fields. When you are satisfied with the Selected Fields list, click on Next.

5. This opens a new window asking what layout you would like for your form. You can click through the available choices and see how they differ. If you are making the main data entry form, choose Columnar. You are going to move things around later, and this is the easiest way to begin. (For a subform to collect data for a subtable, you would choose Tabular.) Click on Columnar and click on Next.
6. Now you are asked what style you would like for your table, and offered several aesthetic choices. Choose one that appeals to you, but do NOT choose one that gives too “busy” a background. You want to be able to see the labels and the data fields very clearly. If you don’t like the fancier backgrounds, choose None. You can always change the color of the background later. Then click on Next.
7. The next window asks what title you want for your form and displays the name of the table you used to create it. This is a form, not a table, so you want to put Form into the name instead of table, and you may also want to call it XX Data Entry Form. You also have the options to Open the form or to Modify the form’s design. Choose Modify the form’s design and click on Finish.

8. The form will open in design view. Click on the datasheet icon in the upper left corner of the Access ribbon to look at the actual finished form, which will be displaying the data for Record #1 of your table. The form will have the right name, and you can see how the wizard laid out the fields and how much space it allowed for each one. Note that a memo field gets a fairly large box, but some of the other fields may not be sized to fit your data.
9. Now comes the critical trick that will let you make changes to a form created with the Form Wizard. Hold the shift key down and click on all of the fields on your form. Then at the top of the ribbon, click on the Arrange tab that is just to the right of the Design tab that you are already on. On the Arrange tab, in the Control Layout section, click on the REMOVE icon.  If you do not click on remove, Access locks all the fields to each other and won’t let you move them around. Clicking on Remove releases that annoying feature and lets you move each field around the way you want to. If somehow they manage to get stuck together, or if you just need to work with one field, you can click on that field to highlight it and then click on the Remove icon to release it. 

10. The basic principle is that you USE the form in Datasheet view, but you can MODIFY it in Design view. You will toggle back and forth to check your changes and fix problems. 
Making a Form from a Blank Form
1. With your database open but all the tables and forms closed, click on the Create tab at the top of the Access screen. Then in the Forms section, click on the big icon at the right called Form Design. That opens a window in design view that shows Form1 with a simple grid. 

2. If you click on the Add Existing Fields icon in the Tools section to the right, it will open the field list for your table. If you have multiple tables it will probably list all the tables, so be careful. Initially, you should just have the fields for one table available and use only those. 

3. Click on a field name in the Field List and then drag that field onto your blank grid. Access will put the field’s name and the field for the data onto the form. You can click on either part and move them around. Play with this a little. If you click on the label (the part on the left, and then move it, usually both the label and the field for entering data will move together. However, you can also move them separately by using the little black square in the corner to move just one part. If you click and release, you can also see little tabs that allow you to change the size of the field. Hover over the little tab and there will be an arrow, which you can then click to drag the field’s edge to make it bigger or smaller.

4. When you have clicked on the data part of a field, at the top of the screen on the left there is a familiar section that allows you to change the font for the field. If you are entering data in another language, you may need to change the font to reflect one that works for that language, such as a Mincho font for Japanese, or a Unicode font that has all the special characters needed for various languages.

5. Add the fields you need in your form and move them around to make the form easier to use. You can put multiple fields on one horizontal row, if they are just numeric fields that do not take up much space. Generally you would put the ID fields first and any other really basic stuff that identifies the records in the table. If you have a bigger text field for a title or something, you may want to put it on the row below, and give it enough space to fit what you anticipate you’ll need. 

6. A text field can have up to 255 characters, half that if it is in Japanese or Chinese. If Access did not give you enough space when the field was initially assigned, you can go back to the TABLE, in design view, and make the field larger by using the field properties at the bottom of the screen. The data is actually being stored in the table, not the form, so you have to change the table first, and then probably close and re-open the form in order for the form part to know that the size of the field has been increased. A memo field automatically expands, so you don’t have to change the table, but you can just make the space for the memo field as big as you think you’ll need. 
7. Don’t worry if it does something you don’t want it to do. You can move it again, and if you have deleted something accidentally you can use the reverse curved arrow at the very top of the screen to undo what you just did. At some point, you should either click on the disk icon at the very top left in order to save the form, or just close the form, which will trigger Access to ask you if you want to save it. Say yes. Since you created it from a blank, it is now just called Form 1, but this is your change to give it a proper name so you can recognize it. Be sure to put FORM as part of the name. Once you’ve saved it, the form will appear with its name in the menu list at the left side of the screen under Forms, and when you open it again the name will appear on a file tab at the top of the form.
8. You can check the effect of your changes at any time, but I recommend that you SAVE first and then switch to Datasheet view (using the icon above the menu part on the left side of the ribbon) to ensure that the changes are recorded. Once you are in Datasheet view, notice that if you click in any field, at the very bottom of the Access screen on the left, you will see displayed whatever you put into the Description field when you created the table. Now go back to design view so you can make further modifications.
9. If you created the form from a blank, it has only its details. It does not have a Title section at the top of the form and it does not have one of the pretty styles Access provides. 
a. If you switch to the Arrange Tab, at the far left there is an icon called Autoformat. It has a drop down arrow that will display the various color combinations available. You can click on one and it will add those colors to your form’s fields.  To see the effect, you have to go back to Design or Home, and get back into Datasheet view.
b. To add a title, get into Design view. Just below the Design tab you’ll see an icon for adding a Logo (which you don’t want unless you want to add an image at the top of the form) and three stacked small icons to the right of Logo. If you hover over the top one, it says Title. Click on it and instantly your form will have a section at the top called Form Header and the name of the form will appear there! The other icons are to add a page number or the date and time, and they are more appropriate for reports, so skip those. If you then close and save the form and open it in form or layout view, you can see the title at the top of your form. It will also still have that little index tab at the top, which will be handy later if you have multiple forms open at the same time.  

Changing the Tab Order

1. If you move fields around so that they are in a different sequence from the original display, or add various bells and whistles later on, you will probably want to change the Tab Order so you can use the tab key to move through the form. Using the tab key ensures that you don’t skip important fields on your form. 
2. With the form open in design view and showing the Design tab at the top of the ribbon, Click on the Arrange tab. In the Control Layout section of the ribbon find the Tab Order icon and click on it.

3. The Tab Order menu box will appear on top of your form. On the right side under Custom Order you’ll see the list of fields in the order they were put into the form originally. There is a small box to the left of each field. Find a field whose location in the tab order you want to change and click to highlight it. Then click and hold the mouse in the same box and you can drag the field up or down to where you want it in the list. By holding down the shift key you can highlight several contiguous fields at once, and then if you’re careful, you can click and hold to drag all of them to a different location together. 
4. When you have finished moving fields around, click on OK to confirm your new order and close the window. (Do not click on AutoOrder, which will take the list back to its original configuration.). 
5. To check the new tab order, SAVE and then switch to Datasheet View. Now use the tab key and see if it moves through the fields in the order you want. If not, you can go back and change the tab order again until you are satisfied with it. 
Adding Action Buttons to the Form

Data entry can be made easier if you add a couple of buttons to the bottom of your form, although you can accomplish the same actions using other features that are already available.
1. When you are in the Datasheet view of your form, you can use the Record Selector at the bottom of the form to move between records. Warning! The number displayed in the window on the record selector is based on a simple count of the number of records, and it does not necessarily correspond to the ID number of the record. The arrows move back and forth one record at a time, and the arrows with vertical bars move to the first or last record. The arrow with an asterisk opens a new record for data entry, and the number to the right of the selector shows you the total number of records you have in the data table underlying the form.
2. Of course, you can always close the form using either the X in the upper right hand corner of the form, or using File/Close on the top navigation bar in the Access window. If you happen to be in Design view when you want to close the form, it is a good idea to SAVE before you close it to make sure any changes are recorded.

Adding a New Record Button

An easier way to begin adding a new record, and to proceed to the next new record when you are entering a lot of data, is to put an Add Record button on the bottom right corner of your form—right where you will be when you finish entering the data for one record. Here’s how.
1. In Design View of the form, move to the bottom where you want to put the button and make sure there is enough room. You can add more space to the bottom of the form just by clicking on the Form Footer and then clicking and dragging on the icon in the center that is a cross with vertical arrows.

2. Now Look at the top right half of the ribbon under the Design tab. You’ll see a bunch of little icons in a section called “controls”. When you hover on any of the icons, a box will appear to tell you what that particular tool does.  However, the Button icon already says “button” right underneath the icon. 

3. To add an action button to your form, click on the Button icon to highlight it and then click on your FORM, in the general area where you want the button to be located. Don’t worry if Access puts it in a slightly different place, because you already know how to move things around.

4. In addition to putting a button on the form, this has opened the Command Button Wizard, which will walk you through getting the button to actually perform some action when the user clicks on it. The first page asks you want action you want to happen when the button is pressed. By highlighting a category in the left side list under Categories, you can see what Actions are available for that category in the right side list.

5. In this case, you want a button for Record Operations, and you want it to Add New Record. 
6. Click on Next to see the next step in the wizard. Here you can choose whether to put text on your button or a symbol. It is less confusing to have the word on the button, so click on Text and then on Next. 

7. This time it asks you to name the button. Just give it the name of the function it performs, in this case Add New Record Button. (This new name may NOT appear in the Tab Order list, but it will appear in other places where you might need it.)

8. Click on Finish and you will see the button now has its proper name. You can drag it to wherever you want it, then SAVE and switch to Datasheet View to see what you’ve done and check that it works. 
9. If you put the button at the bottom of the form, it will appear at the end of the Tab Order list. However, if you put more than one button and don’t arrange them in the order you created them, then you probably will need to go to the Tab Order section as described above and fix the tab order.

Adding a Close Form Button


You can use the same procedure outlined above to add a button to close the form when you have finished entering new data. 

1. Follow steps 1-4 of the instructions for adding a Command Button to move to a new blank record.

2. This time you want the button to perform a Form Operation (Close the Form) so navigate to the Form Operations in the Categories list and then choose the Action Close Form.

3. Follow the remaining steps in the wizard, but name your button Close Form Button in Step 7.

Creating a Subform Linked to the Main Form


You can create one or more subforms that collect information for a sub-table on the MANY side of a relationship to the table underlying your main form. That form is embedded into the main form, and Access will automatically add the ID number from the main record to all of the records in the sub-table. You must first create the subform, and then embed it in the main form. 

Creating the SubForm

1. First, check your sub-table to make sure it has the necessary fields to make the link and collect multiple instances of something per record in the main table. Open the table in Design View and make sure it contains BOTH a unique identifier for all the records in this table AND a field for the ID of the main table to which these records will be linked. If you do not have both fields, you cannot link the tables on the form, or link the data between the two tables. Remember that on your sub-table (the many side) the ID field for the main table is NOT the primary key, because it can have multiple records for one main table record. It is a number field that is set as “Long Integer” in the properties at the bottom of the page. The actual primary key for the sub-table is the field that counts records in the sub-table and it should be set as an AutoNumber field and marked as the primary key. Also add a Sequence field, set as a number field, so that you can record how many sub-table records you are creating for each main record. When the table is set up properly, save and close it. 
2. For a subform you usually want to display things in tabular view, which means the names of the fields go across the top with the data entry place below, and you can display more than one record at a time on the form. This allows you to enter multiple records on the subform that are linked to the one record that is displayed on the main form. You can do this with the Form Wizard.

3. Follow the direction above to use the Form Wizard, but when it asks you what layout you want for the form (step #5 above), say Tabular instead of Columnar. Then go through the rest of the process to create the subform.

4. Now name your subform, and be sure to put the word SUBFORM into the name to avoid confusion later. Check that you want to Modify the Form, and click on Finish to exist the wizard and see the new subform in design view.

5. This form will look a bit different from the main form.  It will have a row across the top called Form Header that gives the labels for each field, and then below the bar called Detail, it will have the data box for each field. 
6. Remember that in Access 2007, before you can make any adjustments you need to hold down the shift key, click on all the fields in the form, then click on the Arrange tab, and then click on the Remove icon in the Control Layout section of the ribbon. Once you do that, you can adjust the size of the fields as needed. You can also simplify the name in the label field if you want.  (Sometimes it has a long name but only needs a little space, such as for a numeric field, so deleting the unnecessary part of the name lets you shrink the space it takes.)
7. Once it is on your main form, this subform will expand automatically to capture multiple records. Adjust the Form Footer so that there isn’t blank space left at the bottom of the form. You can adjust for how many records you want to display at once after you get it onto the main form. 

8. Save the subform and switch to Datasheet view to see what it looks like. If you are satisfied with the form, you are now ready to attach it to the Main Form. Close the Form, which will return you to the main menu page and you should still be on the Forms part of the menu. Both the main form and your new SubForm should be listed.

Embedding the SubForm on the Main Form

1. On the Forms menu, highlight your Main data entry form and then click on the Design icon, to open the form in Design View. 

2. Decide where on the form you want to put the subform, based on where it would logically belong in the coding sequence. Then move things around and expand the length of the form so you have room to put the subform onto the main form. You already have some sense of its size, but you can make further adjustments later. (Make sure you have already gone through the procedure described above to unlock the parts of the main form by highlighting the fields and using Arrange/Control Layout/Remove on the ribbon.)
3. In design view, in the Controls section, find the SubForm/Subreport Icon just above the word Control and click on it once. Then move your cursor roughly where you want the subform to appear on your form and click once. This will open the SubForm Wizard. The first page asks where the data is. Click on Use an existing form, and then click on the Subform you want in the list and click on Next.

4. Now the wizard asks what fields to link. Read what it has written below the box. If that is correct, you can make sure it is highlighted and that “Choose from a list” is checked above, and then click on Next.  (On the other hand, if you don’t like or trust the options Access provided, choose Define my own. This opens one column for the Form fields and another for the Subform fields, and you can choose the linking field from both lists. ) When you’ve established the link, click Next.

5. Now you get to name your subform as it will appear on the main form. It should display the name you already gave it, and you can just accept that and click on Finish.
6. The wizard will close and your subform will appear on your main form. Adjust its placement and make sure you can see both the labels and at least one row of the data fields, and that you haven’t hidden something behind the subform on your main form.

7. This will have affected the tab order if there is anything after the subform, so go to Arrange/Tab Order and move the combo box up to its proper place in the sequence. Then Save your form and take a look at it in Datasheet view.
Attaching the Code List from a Lookup Table to a Form or SubForm


It is helpful to have all the code categories from a lookup table right on your form so you can simply choose the desired category and have the code added to your data. A lookup table may be added either to the main form (for a code that has only one instance per record on the main table) or to a subform (for a code that would apply to each record on the many side of a relationship and be collected through a subform and added to records on a sub-table.)

1. You must first have a Lookup Table that contains a field for the numeric code and a field for the name of the code category. It may also have one or more additional fields, but these usually will not be displayed on the form.
2. You also need to identify the table that will collect the data for this code. If it is a single instance per main record, then you just need to have that code field on the main table, with a name that is the same or similar to the code field on the lookup table. If there can be more than one instance per main record, then the lookup table will need to have a corresponding collection table, which will collect these instances onto a sub-table, through a subform. 

3. If you are collecting the data on a sub-table, often you will only know part of the code when you begin. Therefore, you will need an additional field on your collection table for cases in which you just enter the raw data because you do not yet know how to code it. This should be a TEXT field if possible, so it can be sorted. You can also add a memo field to the collection table if you want to preserve bigger chunks of contextual information. 

4. If you find that you need to add some fields to your collection sub-table, do that first so that everything will work properly. If you have already created a subform and now realize it needs some more fields, you can add the fields to the table, and then open the subform in Design View, expand the subform horizontally, and use the Field List on the top navigation bar to add the additional fields. (Or you can just delete the subform and start over with the Form wizard. 

5. When you are ready to attach the lookup table’s list of code categories, open the Form that will hold the list in Design View.

6. Locate the field on the form that is already set up to hold the code. It will have a label field and code field. Delete the data field.

7. Now, on the Design Ribbon in the Control section, find the Combo Box icon. It is the top one above the word Control. It looks like a list but has a little blue down arrow in the upper right corner. Click on it once to highlight it, then move the cursor to your Form and click again. This will place a marker on the form and open the Combo Box Wizard. 

8. It asks you where the box will get its values. Click on the first option, “I want the combo box to look up the values in a table or query.” Then click on Next.

9. The next page shows a list of the tables in your database. Your lookup tables should be identified with Lookup in the name. Find the one you want, and click on it. Click on Next.

10. The next page asks which fields you want in your combo box. You need the Code field and the field that gives the name of the category. Once these are selected, click on Next.

11. Now you are asked how you want the list sorted. Pick the field to sort, and click ascending to get it in alphabetical order. Click on Next.

12. The next page allows you to adjust the width of the box. Usually it has the code field too wide, and the name field too narrow, so fix those to make the list easy to read. Then click on Next.
13. The next page asks you which field has the value you want to store. Click on the CODE field, not the name field. Then click on Next.

14. The next page asks you where you want to store the value. Click on “Store that value in this field” and then identify the CODE field in the collection table and click on it. Then click on Next.

15. Now you can name the combo box. I’d put combo box into the name, or lookup, so you can identify it easily. Then click on Finish.

16. The wizard will close and you will see your combo box on the form. If it is on a subform, it probably is covering up other fields. (It may be easier to do this if you add some temporary space below the line of data fields, move the label out of the way, and then adjust the field with the down arrow. Then click somewhere else on the page and then carefully click on the label, use the little box in the upper left corner of the label to move it a bit more to make sure it is moving separately from the data box, and then delete the label. You may need to go through the Arrange/Remove routine to get the two parts to separate, and then play with it a bit in Design view, but you can get it to work. Then save the form and check it.
17. The tab order may be wrong now, because the new combo box will appear at the end of the list. So fix the tab order, save, and then check again.

Best Practice for Maintaining Your Access Database


Now that you have an Access database and you are starting to code data into it, you need to make sure that you protect the database and maintain its relation to the original data.

1. If your raw data are on paper or are stored in your computer as files, develop a simple system so that the ID number for the main records in your Access database is also recorded on the raw data in some way. In some cases, you don’t need the ID because you are coding articles and you have the date of the article both in the database and on the original. Then you simply need a filing system that keeps the raw data in order so you can find things if you need to go back to the raw data.

2. You also need a simple procedure so you can tell what has been coded and what has not. With pieces of paper, this is as simple as keeping two stacks, for coded and uncoded items. For computer files, it may be better to create two separate folders, for coded and uncoded materials, and move them from one folder to the other as you complete the coding.

3. If your data source is relatively small individual items, such as newspaper articles, and particularly (but not only) if the data are already in computer files, you can add a memo field to your main table where the items are initially coded, and then arrange the data entry form so that there is a very large memo field at the right of the page, elongated if needed. Then you can actually start your data entry by copying and pasting the entire articles into the records, and then pasting in the title and other identifying information. You can fairly quickly copy and paste all of the articles into the database, with Access assigning the ID number to each record as you proceed. Once you have that basic information in the database for all your cases, it is much easier to go back and code the rest of the information because the raw data is right there and things can easily be copied and pasted and other fields can be filled in. That also means you are much less likely to lose track of the data, and it is much easier if you later need to go back and code additional information. If you do this at the beginning and later find that you’ve copied and pasted and assigned ID numbers to some articles that you do not want to include in your study, you can either delete those records, or add a field to the table that indicates whether you will be using a record in the sample. Then you can easily mark the records. Just don’t forget to use that code to filter the records whenever you are working with them, so the irrelevant ones are left out.  
4. For any raw or coded data you are storing on a computer, you need to make backup copies. Burn a copy to a CD, date the CD, and put it somewhere safe. Burn a new copy periodically if you are doing any coding or annotating on the computer files.

5. For Access databases, you need to create and save backup copies regularly and keep them in more than one place. 

a. For larger projects in which there is an Access database on a standalone computer, I generally maintain a set of three zip disks and have coders copy the database to a zip disk at the end of EVERY coding session, put the date on that disk, and move it to the bottom of the set. That means the three disks are being rotated and we always have three backup copies to protect that last three sessions of work.

b. For your current project, a simpler solution is to copy the database at the end of each coding session to a different location, IN ADDITION TO THE MAIN FILE YOU USE EACH TIME, and put the date into the file name of the copy. You will accumulate a growing set of these backup copies, and when you run out of storage space, you can delete the oldest ones. Keep these backups separate from the one working file that you always open and work on (in a different folder, computer or USB key), so that you don’t get confused and start working on the wrong copy. 
c. As you work with an Access database, it gets bigger, but a lot of the extra space is wasted. You can periodically use the Compact and Repair function to clean up the database and you will be amazed at how much smaller it becomes. In Office 2007 this can be set to happen automatically when you close the database. In older versions you generally need to do it manually. Always make sure you have a copy before you do that, just in case!
